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Oregon Extended Assessment Development Process
Item/Test Development Guide
Step 1: Standards
Essentializing Common Core State Standards (CCSS), OR Science Standards (ORSci),
and Next Generation Science Standards (NGSS)

1. Locate CCSS, ORSci, and NGSS Excel spreadsheets.

2. Review all grade level standards and target those standards that were most
important to teach, demonstrated the greatest opportunity to learn, and
required content knowledge and skills that remained important across
grades 3-8 & 11. Standards that were not included are highlighted red.
Standards that are included as part of the essentialization for a related
standard are highlighted green, with the associated essentialized standard ID
noted.

3. Once standards were selected, implement the essentialization process to
generate Essentialized Assessment Frameworks (EAFs), which are composed
of Essentialized Standards (ES) written at three different levels of complexity
(Low/Medium/High)

a. Essentialization process (see "EssentializationProcess_V6")
b. Essentialized Assessment Frameworks (see EAF documents in English
language arts, mathematics, and science)

4. Linking study - All ES were reviewed by our item writers in order to gather
documentation regarding our selection of standards as well as the level of
linkage between the ES and the grade level standards. The linking study
report will be included in the 2014-15 ORExt technical report. The average
rates of agreement are very high regarding standard selection (98%) and
linkage ratings are also strong.

Step 2: Item Development

1. All teachers and content experts involved in item development were trained
using the materials found in the Training PPTs folder (see "
[temWriter_Training_2014_V4").

2. Training materials included Test Specifications that explained our approach
to assessment, provided example items, and also addressed accommodations
(see "Test Specifications/ORExtTestSpecs_2014_V6")

3. Teachers were provided copies of the EAFs where each ES had an exemplar
item, in which the level of complexity was stratified across all standards
(L/M/H).

4. Project leads worked closely with each item writer, reviewing and providing
feedback on initial batches of 20-30 items to ensure that writers were on the
right track. Review of items and communication with item writers continued
throughout item development.

5. We used 8 item writers in ELA, 7 in Math, and 6 in Science. All item writers
had MA degrees or higher with one exception who was a PhD student.



Step 3: Item Review
Distributed Item Review (DIR) by Oregon Teachers (http://brtitemreview.com).

1.

Once items were written to align to all ES and the three different levels of
complexity (L/M/H), items, standards and graphics were uploaded into the
Distributed Item Review (DIR) website review system. Item reviewers were
trained in person (see " ItemReviews_Fall2014_V5")

CSV spreadsheet templates were used to upload test items into the DIR with
the following column headings: Item ID, Group (grade), Standards (ES code),
[tem Information (the item prompt, as written for the Scoring Protocol),
Prompt (the item prompt, as written for the Student Materials), and Option
A, Option B, and Option C (answer choices), and Correct (correct answer
choice location [a, b, or c]).

There was also a spreadsheet template (created in Excel and saved as a .csv)
for uploading ES into the DIR, with the following column headers: Standard
ID, Subject (English, Math, or Science), Domain (the ES), and Description (the
L/M/H complexity descriptors).

A zipped folder containing graphics files (.png), associated with items as well
as graphics location (e.g., which part of the item the graphic goes with—stem,
answer a, b, or c) through the developed coding system, was used to upload
and associate all items and graphics. The coding system was critical to the
above procedures as it was the means to link items with standards with
graphics. Additionally, each code provided information as to the grade,
subject, ES, complexity level (see 5-7 below).

Standards Coding: We coded ES using this approach: MO3NOF1.2a. The first
letter is the subject (M = Math), the second two numerals are the grade (03 =
grade 3), the next three letters are the domain (NOF = Numbers & Operations
with Fractions), and the final portion is the standard identifier (including
sub-standard, where relevant, the "a" at the end).

[tems Coding: We matched the item code to the standard it was linked to and
then added the complexity level and item number. To tie in with the above
example, we would have written: MO3NOF1.2aL04. This tells us thatitis a
low complexity item, and the fourth low item written to the ES. The number
of items written to each ES was dependent on the number of ES at a
particular grade-level, with L/M/H complexity stratified as evenly as possible
across all grade-level ES..

Graphics Coding: We matched the graphics code to the item code and the
location of the graphic. For example, item SO5LFS2.1M21 had graphics
associated with the stem and three answer choices (a, b, and c). Thus, the
graphics files were named SO5LFS2.1M21.png, SOSLFS2.1M21_A.png,
SO5LFS2.1M21_B.png, and SO5LFS2.1M21_C.png, respectively. Again, we
cannot emphasize how important this coding system became, particularly as
we needed to automatize the process using R and InDesign/Illustrator toward
the end. It was probably the singularly most important factor in terms of our
efficiency and accuracy.



8. The questions we used for the ORExt DIR review were the following:

9.

a. Rate the strength of alignment between the item and the standard(s)
(0 = insufficient alighment, 1 = sufficient alignment, and 2 = strong
alignment)
. Item is free of bias (Yes/No)
c. Item is accessible to SPED students (Yes/No)
d. Comments (asked reviewers to comment on any "0" or "No" ratings,
particularly with suggested improvements)
We used 21 reviewers in ELA and Math and 10 reviewers in Science (3
reviewers per grade level; two SPED and one GenED cohorts). Science had
four reviewers per grade level, the fourth a content specialist from ODE, who
reviewed items from all three grades (5, 8, and 11). All reviewers were from
Oregon and had at least five years of teaching experience.

Step 4:
Review all OR teacher feedback and update items

1.

3.

The DIR system generates CSV spreadsheets with the ratings for each
reviewer, for each item. Reviews were organized by grade level within each
content area. Reviewer ratings and comments were organized into a single
spreadsheet (by grade and content area) and analyzed for the degree of
alignment, bias, and accessibility, typically examining means, counts and
percentages of ratings across all items.

Every comment for every reviewer was digested (close to 28,000 lines of text
for ELA and Math, and about 12,000 for Science). We documented all of our
(editing) decisions related to reviewer comments within the spreadsheets
within the BRT Response column.

All items requiring editing (text, graphics, or otherwise) were edited within
Excel, using the DIR as a means to examine items “in situ”, and saved on
Infostore within the DIR folder identified in Step 3.

Step 5: Scaling/Item Selection

1.

2.

3.

The vertical scaling plan was a balanced design resulting in a vertical scale in
grades 3-8 in ELA and Mathematics.

Test blueprints were used to determine balance of items (see
"ORExt_TestBlueprint_2015").

The Excel spreadsheets identified above were then parsed into separate
grade levels and forms in a CSV format.

Step 6:
Creating CSV files for merging into InDesign

1.

Copy multiple file paths to the clipboard using Automator Tool (Finder -
Applications - Automator) and paste into Text Editor. Automator tool is a
Mac function and looks like this:



2.

Automator

Here is the link to all of the instructions for setting up your Automator. Once
it's set up, you will never have to do this again as it system service available
by highlighting files and right-clicking:
http://www.macyourself.com/2011/12/31/copy-file-or-folder-path-to-the-
clipboard-in-mac-os-x-lion/

All files will be copied on your clipboard. Open your Text Editor and use
CMD-V to paste your filepath names into an Excel/text file.

NOTE: After realizing how long the process of organizing test form information
into spreadsheets was taking, R programming was used to run all of the
functions you see below. Thus, it is best to use our R package for this purpose.
However, here are the steps if it must be done by hand.

3.

v

@

10.

11.
12.

13.

Copy/paste the file path names from your text file into a new Excel
spreadsheet, and save as something like “Gr3FilePaths” (i.e., the file path
spreadsheet).

Open spreadsheet with item information.

Create new spreadsheet with template headers (see Shawn’s Science
example G5SCI15_form1_v1).

Copy/paste list of form IDs from vertical scale document into template
spreadsheet (i.e.,, G5SCI15_form1_v1).

Using Find command (CMD + F) locate the first item in the item information
spreadsheet. Hit escape (Esc) to close Find dialog as a shortcut once item file
path is found.

Select all item information (Shift + CMD + right arrow).

Copy/paste selected item information into template spreadsheet under
Group column heading - it’s okay at this point to have the item ID repeated
b/c we'll use it as a double-check later.

Repeat this Find - Copy/paste for remaining items in the test form. You may
quickly switch between the item information spreadsheet and template
spreadsheet using keyboard shortcut (CMD + ~), which allows you to toggle
between windows within a given program (i.e., Excel).

If necessary, delete column of item changes comments.

Highlight column C, and insert a blank column, and use Exact function to
double check that your item IDs match. Enter "=Exact(A2,B2)" and drag
formula down for entire column. You want to see all “TRUE”s. If you see a
FALSE, it may still match, but be an all-caps issue.

Delete this information from Exact function column we just created, as it's no
longer needed.



14.

15.

Under Group column, replace item IDs with grade for all 48 items in test
form.
Under Item column enter 1 through 48 to indicate items 1-48 on test form.

All 48 test items and all item information for a given test form is now entered into
the template spreadsheet. The last step is to find and copy/paste the file paths into
the last four columns, as needed, based on the item.

16.

17.

18.

19.

20.

21.

Close item information spreadsheet because you will not need it again until
you create and populate the next template spreadsheet (i.e., form 2, 3...)
Using Find command (CMD + F) locate the first item’s file path in the file path
spreadsheet. Hit escape (ESC) to close Find dialog as a shortcut once item file
path is found.

Copy/paste selected file path(s) for the given item into template spreadsheet
under appropriate column heading (i.e.,, @Graphics_Stem, @Graphics_A,
@Graphics_B @Graphics_C) - BE CAREFUL, based on how the file path
spreadsheet is sorted because they maybe be out of order (i.e., the stem file
path will be after paths for answer options A, B, and C in some cases for Math
and Science).

Copy/paste special (or cut/paste if it'’s only a stem graphic file path) into
item template spreadsheet using keyboard shortcut (CTRL + CMD + V), which
brings up Paste Special dialog box, click Transpose and OK to paste into
appropriate cells in item template spreadsheet.

Repeat this Find - Copy/paste special for remaining items in the test form.
Again, you may quickly switch between the item file path spreadsheet and
template spreadsheet using keyboard shortcut (CMD + ~), which allows you
to toggle between windows within a given program (i.e., Excel).

Clear file paths as you finish each item and return to the file path spreadsheet
**this is personal preference, but it makes selecting multiple file paths a little
easier, and lets you keep track of progress**.

Step 7: Data Merge

Note: Graphics need a ":" instead of "/" in csv spreadsheet. Using CMD + F to conduct
replacement of only those columns worked very well as a procedure.

Creating Student Materials templates:

1.

2.

Create a new InDesign document (File > New > Document) - uncheck ‘Facing
Pages.’

Under the Pages menu on the right hand side, top of the Pages menus, you
will have a "none" and a "Master A" template already. Begin with the Master
A - double click on the Master A page to format.

Create text and graphics boxes using the toolbars, placing placeholder boxes
on your Master page. If more than one Master is needed, use the small arrow
at the top right of the pages menu and select "New Master."



4. Repeat steps above using the toolbars to places text and graphic boxes where
needed.

5. Next, select ‘Data Merge’ from the ‘Utilities’ menu. Select your data source.
You will now see all of your header fields listed within the data merge menu.
You can either click inside the box in which you wish the field to appear, or
drag and drop the appropriate field header into the box on your Master
template of choice.

6. Within each text box you can center/format font/size, etc. to make them
uniform using the font and paragraph formatting in the top tool bar of
InDesign.

7. To center text and graphics within the boxes:

* Select Object Styles

* Create New style (square to the left of the trash can)

* Double click on new (Object Style 1) - rename (Sev called these graphic
frame or text frame depending on what she was formatting)

* Under Basic Attributes, double click on Text Frame General Options, at
the bottom in the Vertical Justification drop down menu select ‘Center’

* Then double click on Frame Fitting Options (last item in Basic Attributes)
and in the Content Fitting drop down menu select ‘Fit Content
Proportionally’

* Select boxes that include text or graphics and click on the new object style
to apply to these boxes

Before actually merging the document, be sure to create an actual document page
for each Master template. Click on Page 1 in the lower section of the Pages menu. Go
to the small triangle menu in the right hand corner and select ‘Apply Master to
Pages’ - selecting appropriate master. If there is more than one Master, create a
page 2 using the small paper icon in the bottom right of the pages menu next to the
trash can symbol. Double click on page 2 and select ‘Apply Master to Pages’ -
selecting the next Master template. Repeat this until you have one actual document
page for each Master page. This will create one Master template for each item once
merged so you can then go back through, select the appropriately formatted page,
and delete the unneeded pages.

Scoring Protocol Formatting

1. Because we want multiple records per page, do not create an actual master
page. Put the formatting for the first record on page 1. The master page will
have the header/footer continued on each page.

2. For the prompt/item information box, go to the paragraph menu (top left

hand tool bar) and make sure hyphenate is not selected.

For the data merge select multiple records in the drop-down menu.

Multiple Record Layout - make sure 'Rows First' is selected.

Options - In the 'Image Placement' menu, select 'fit images proportionally.'

Make sure the following are selected:

a. Center in Frame

v W



b. Link Images

C.

Remove Blank Lines for Empty Fields

6. After Data Merge you will get a notification if there are any graphics or text
that are larger than the boxes. If you go through the document in ‘Normal’
mode the areas with overset text/graphics will have a - These will need
to be resized by hand.

Note: When using an existing template for a data merge, be sure to remove the
existing data source and add your new source. You will see a pop-up telling you the
fields may not be the same, but as long as all of our spreadsheets have the same
header rows the templates apply across all spreadsheets.

1. Format Spreadsheet

Replace periods (.) with spaces in head rows

Add a single apostrophe and the at symbol (‘@) before header in
graphics columns

Delete all paragraph returns in prompt column

Check answer options (some show up as dates instead of fractions,
special symbols and exponents are lost and need to be denoted, etc.)
Find/replace graphics file paths (swap colons for forward-slashes)

If you close or re-open file, add as single apostrophe (‘) in the graphics
headers again

2. Data Merge for Student Materials

Open template, when prompted select ‘Don’t update links’ because
you will be using a different spreadsheet.

‘Data Merge’ can be found in the Window menu under ‘Utilities’.

Use the small triangle on the top, right-hand corner to pull down the
data merge menu. Remove data source. Then Select new data source.
Click the ‘Merge records’ option at the bottom right of the data merge
menu. [t will automatically tell you if you have any overset text or if
the program cannot locate any graphics, in which case you have to go
back to your spreadsheet and graphics folders and track down the
graphics. Overset text can be formatted by hand as you edit the SM
document, so don’t address that yet.

‘Save As’ right away after the merge is complete. Select the pages
menu and go through by hand to decide which template you want to
keep per item, then drag the un-needed pages into the trash (bottom
right of pages menu). Make sure that you select the appropriate
template for each item, as it is time-consuming to rebuild the item if
the template is not selected correctly. We always ended up with 48
pages total, when finished.

Once the necessary pages are selected, go back through each and
added back in the soft returns where needed (a space in between
paragraph returns is included) and resize the ‘square’ graphics.



Go to each of your master pages and update the grade level in the
header, if necessary, as you proceed.

Add a page in the beginning just as a placeholder title page (this will
appear as page 2, so drag to the left of page 1 to get this as the first
page) - select apply master then select ‘None’. The subject and grade,
form number, and SP or SM, are on the title page.

Done! Now export to PDF either under File - Export or (CMD + E).

3. Data Merge for Scoring Protocol

Open template, when prompted select ‘Don’t update links’ because a
different spreadsheet is used.

‘Data Merge’ can be found in the Window menu under ‘Utilities’.

Use the small triangle on the top right hand corner to pull down the
data merge menu. Remove data source. Then, select new data source.
This will most likely have overset text, which must be formatted by
hand.

‘Save As’ right away again.

Now go through by hand and edit the overset text boxes. There will be
a i on the right side of the box when the text is overset. It may be
necessary to shift the answer options and scoring boxes to fit the text
in the item information box. Note: It was a good indicator that items
had too much text if they did not fit in the SP template, however.

Go to each master page and update the grade level in the header if
necessary.

Now that all is formatted, go back to page 1 - do the same as SM and
create placeholder title page. Insert new page, drag to right of pg. 1 to
get to appear first. Select ‘Apply master to pages’ - ‘None’. Then create
placeholder title page with subject/grade/form/SP.

And SP is done! Export (CMD + E) to PDF.

NOTE: All final graphics that resulted from many rounds of editing are housed
within a common folder on our server.

Step 8:

Final Test Package Creation Process

Nk wh e

Open Adobe Acrobat Pro X (the directions are a bit different in XIV)
Select "Combine Files into PDF"

Drag/place the first insert, "1_ORExtTestFormInsert_2015.pdf"
Drag/place the second insert, "2_0AKSTestInsideCover.pdf"
Drag/place the third insert, "3_ORExt_TestAdminInstruct_V7.pdf"
Drag/place the relevant Scoring Protocol

Drag/place the relevant Student Materials



8. Drag/place the fourth insert, "4_ORExtScoringSheet.pdf" It should now look

something like this:

[ JON ) £%) Combine Files

%Add Files... v © single PDF PDF Portfolio
Drag and drop files to add them, and then arrange them in the order you want.

Name Page Range Size Modified Warnings/Errors

7_:1 ORExtTestForminsert_2015 All Pages 347.11 KB 1/25/...8 AM

5 2_OAKSTestInsideCover All Pages 141.09KB  1/7/1..3PM

7_:8 OREXxt_Tes...inInstruct_V7 All Pages 60.77 KB 1/20/...2 AM

5 MathGr3_Form1_SP_VF All Pages 996.20KB  2/3/1..5PM

5 MathGr3_Form1_SM_VF All Pages 2.63 MB 2/3/1...7 PM

'L: 4_ORExtScoringSheet All Pages 28.32 KB 1/8/1...5 AM
G Move Up Move Dow @Choose Pages L;,l Remove File Size: O D D
Help Opticns Combine Files Cancel

9. Select "Combine Files"

Adobe Acrobat Pro will generate a "Binder" Save the Binder file using the

following convention, subject, grade, form number, year. Here is an ELA,

Grade 3, Form 1 example: "ELA_G3_Form1_2015"
10. Select "Tools" then "Pages" then "Header and Footer" Insert a page number
in the right-hand footer (Arial, size 8). Add the text "Page" and one space prior to
the number with the double less than and greater than signs (Page <<1>>). Your

10



command bar will now look like this (see below). Click OK

[ Add Header and Footer
Saved Settings: [Custom-not saved] Save Settings...
Font
Name: Arial Size: 8 U n

Appearance Options...

Margin (Inches)

Top: 0.5 Cl Bottom: 0.5 °

Left: |1 z Right: 1 <

Left Header Text Center Header Text Right Header Text
Left Footer Text Center Footer Text Right Footer Text
Pagek<1>>
Insert Page Number Insert Date Page Number and Date Format...
Preview
Preview Page |1  of63 Page Range Options...
I I
] I
I 1
i |
""""" OFFICE-OF LEARNING & -f-o ' T
T '
| STUDENT SERVICES 3 |
—_— —
AN
i i
I I
' 1
____________ Sy EU
' Page 1!
] I
] I
I I
I 1
Help Apply to Multiple Cancel [ ok |

11. Select Forms, then select "Edit". You will be asked if you want Acrobat to find

the form fields in the document. Select "NO"

1 MTH_G3_Form1_2015.pdf

B

Tools Comment Share

Page 1

8-

» Pages
» Content

v Forms
@ Create
| B o |

@ Distribute

Add or Edit Form Fields

" Currently there are no form fields in this PDF.
Do you want Acrobat to detect form fields for
you?

No Yes

T ———
1 a priority of the Oregon Department of Education
it on the grounds of race, color, religion, sex, sexual
v educational programs. activities or emplovment.

Track
| Highlight Existing Fields }

@ More Form Options v

» Action Wizard

» Recognize Text

» Protection

» Sign & Certify

» Document Processing
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12. Add two form fields in the footer. First, you will select "Add New Field" then
select "Text Field" (see below).

Forms

P v Tasks

£} Add New Field v

Text Field
Check Box
Radio Button
List Box
Dropdown

Button

Digital Signature  ~ or ~

EHEYESOBHE

Barcode

Field Type Help

™1 mwdae I

13. Now, this part is a bit more complicated. On the first page, scroll down to the
bottom. The top of the first text box must have its top at 10.5" and its bottom
at 10.75" (this makes the field .25 inches high). The left side of this text box is
right where the Secure Test notice text above begins. The right side extends
to 3". Once the box is placed and sized, enter "order_id" as the field name and
select the "Required field" setting (it may be necessary to right click and
select "Rename field" to be able to change the name if it isn't automatic). It
should look just like this now:

12



5 Test Security - The security of asse
tion are vital to maintaining the val
materials are secure and must be aj
dizes student information and puts
the ODE 2014--2015 Test Administra

1
0
=
-
Field Name:
1 Iorder id l |
1
Required field All Properties

Now, enter the second footer box. This box has the exact same height settings
as the first, but runs from 3.5" to 7" on the width. This places it just to the left
of the page number you entered earlier. Name this text field
"order_recipient"” and then save the document again. It will now look like
this:

] Test Security - The security of assessment instruments and the confidentiality of student informa-
tion are vital to maintaining the validity, reliability, and fairness of the results. All test items and test
materials are secure and must be appropriately handled. Failure to honor security severely jeopar-
dizes student information and puts the operational test at risk. For additional information refer to
the ODE 2014--2015 Test Administration Manual or contact your school or district test coordinator.

| Page 1

14. This is the final step before an overall QA of the document. All that is needed
once "order_id" and "order_recipient” are spelled exactly as they are on the
first page next to Test Form ID and Assessor Name, simply duplicate this test
form field across every page of the document. This is done by right-clicking
and selecting "Duplicate". When asked, select OK, which performs this
operation to the default setting, which is All pages. It should look like this:

13



Duplicate Field |

Duplicate this field on which pages?

2 Al

From: To: of 63

cancel | (IS

The document should now have this footer on every page. Select "Close Form
Editing" to exit the form editing portion of Acrobat Pro.

15. Verify overall document contents:
a. There should be 63 total pages.
b. The test should be cover page, ODE inside cover, two-page test
administration instructions, SP, SM, then scoring sheet.
c. Make sure that everything looks good, editing as needed/appropriate.
16. Save a copy to Infostore and save a copy on your laptop.
17.Move on to the next form!
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